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Introduction

Thank you for purchasing Gaia.
Gaia is a set of assets, tools and processes to create beautiful 3D worlds.

Quality environments contribute to the success of your game with a combination of
enhanced realism, visual storytelling, immersion, engagement, aesthetic appeal.

Our intention with Gaia is to make world building easy for newcomers, flexible for pros, and
to free you up to create the engaging and satisfying player experiences that lead to positive
word-of-mouth, critical acclaim, and ultimately higher sales and success for your game!

Gaia exists to help you succeed, and this document exists to help you succeed with Gaia!
In a nutshell:

e Gaia workflows start with Gaia Manager. Gaia Manager allows you choose the
operation you want, and then instantiates and configures the tools needed.

o Terrain Shaping is done via Stampers. A stamper treats your terrain like cookie
dough, and ‘stamps’ interesting shapes into it, such as mountains, hills, mesas,
valleys and rivers. Stamps are designed to be mixed and matched to create any
terrain you want.

o Terrain Population is done via Spawners and Biomes. Biomes are sets of spawners
that contain assets and the rules needed to apply those assets into your scene. You
can use our biomes or create your own.

¢ Runtime Systems are controlled via Gaia Runtime. Runtime systems include skies,
lighting, water, audio, culling and streaming and player controls. These systems are
provided as installable modules to make it easy and fast to test scenes.

o Adhoc Tools are accessed via the Advanced Tab in Gaia Manager. Tools include a
Scanner to create new stamps, a Stitcher to stitch terrains together and a Terrain to
mesh converter for the creation and optimization of low poly environments for
mobile and VR.

For a deeper dive including video tutorials, support forums, your free stamp packs, and
more products, please go to Canopy.

Gaia is a labour of love. | hope you enjoy using it as much as we enjoyed creating it!

Warm regards,

Adam Goodrich.
Founder, Procedural Worlds.
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What can | create with Gaia?

These images were all created with Gaia using the same basic workflow.

Create a terrain, populate it with a biome, and then detail it to make it interesting and
relevant to the game.

Some of these are included with your version of Gaia, and all of this is possible with Gaia if
you create your biomes.

Gaia worlds are used on desktop, mobile and even VR. Your environments need to be
created with the target platform and performance optimization in mind.

Your levels will also need detailing for your unique story. Detailing is the process of
creating towns, buildings, roads, paths, and rivers. Gaia’s stable mate GeNa can help.
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Inline help, library, and support forums

Inline Help
Most of the systems in Gaia contain inline help.

In the image below you can see a ‘?’. Clicking this opens and closes the help system. The
help system can also link to web pages with more detailed information.

Gaia Pro (3.3, S, Unity 2022.3.1f1) English

3. Create Runtime
- 3. Create Runtime

Online Help

Free Stamp Packs!

Canopy Library

The Gaia section in the Canopy Library is where we store our latest documents and video
tutorials. Click here to view it. You can also access this via the Help Tab in Gaia Manager.

Canopy Forums for inspiration and support

If you need help, then please browse or search the Gaia forum on Canopy. You can find the
forums here. The search box is highlighted in red.

If you are unable to find the solution you are looking for, then register and put your own
post into the forum. Video or
screen shots are best so we have Cano QRS kS
the information needed to help
you.

The forums do not always notify
us of your request, so if you do
not get a response within two

Gaia & Gaia Pro 2021 Register your assets

business days then send us a :
message on Discord with a link to
your post.

2 3 4 5 5 o o>

§ (@ Unity Releases - Beta vs Tech Stream vs LTS vs Render Pipeiine

@ @ Gaia Tutorfals & Knowledgebase
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Additional products and services

Canopy for product and subscription services

We have over fifty assets ranging from tools to procedural content packs, to game
templates and game ready levels. Check them out on Canopy, or the Unity Asset Store.

We also have a special subscription offer at Canopy. With this you get access to all our
non-enterprise products at substantially cheaper rates than purchasing them outright.

Massive runtime worlds and more performance with Storm
For massive open worlds on mobile and desktop then please consider Storm.

Storm delivers crazy draw distances and frame rate improvements of up to 100x on
mobile and desktop, with support for all pipelines.

This is an advanced system is for professionals who are serious about delivering the best
possible quality and performance with Unity. To learn more please contact us.

Custom solutions & professional services

In addition to creating tools we also offer professional services. Some of the companies we
have worked with include Wargaming.net, Unity, BMW and Google.

If your project could benefit from our unique expertise in procedural generation, world
building at scale, and advanced rendering then please contact us.
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Setup

Version Differences:
This guide covers Gaia 2023 and Gaia Pro 2023.

Gaia and Gaia Pro are essentially the same systems; however, Gaia Pro adds additional
utilities, operations and biomes.

Some of the more significant enhancements in Gaia Pro include:

¢ More biomes and sample assets

e Large world and terrain streaming support

¢ Additional stamping, erosion and masking operations
e Low poly and terrain impostor support

¢ Weather systems, and more.

If you have Gaia and want to upgrade to Gaia Pro, we have removed the cost of Gaia from
the upgrade price. The upgrade process itself is seamless.

Prerequisites:
To get the best out of Gaia we recommend the following:

¢ Use a decent development machine. A good base build is an Intel Core i5 or better,
16gb ram or better, and a Nvidia 2060 or better. A fast SSD will also speed your
process up substantially as Unity is disk intensive.

e Make sure your GPU is relatively recent and has at least 4GB VRAM. Gaia makes
extensive use of the GPU to do its magic. If your GPU does not have enough VRAM

then you will experience crashes.

e Make sure your graphics drivers are up to date. Old drivers are a common cause of
random crashes.

e Make sure that automatic light baking is turned off in the Unity editor. This system
has a long history of causing crashes.

o Stick to LTS releases of Unity. Everything else is considered by Unity to be a
technical preview, and they are often quite buggy.

e The bigger your environment is, the longer it will take to generate, especially on
large multi tile worlds. World creation is computationally expensive.
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e Use source control. Everyone loses their work at some point. If you are backing it
up, then no problem! We added some useful settings for this later in this document.

Installation Directories:

Gaia is installed into the Procedural Worlds directory. In here, you can find

\Procedural Worlds
\Frameworks - Common frameworks across all products

\Packages - Cache - Contains the uninstalled installation source package files for
Gaia and additional modules

\Packages - Install - Contains the installed Gaia application and the installation of
additional modules

\Gaia User Data - User generated sessions and settings

The Gaia User Data directory where we store global settings and Sessions. It contains the
actual output or the result of your work that you create with Gaia.

A new Session directory is created for every terrain you make with Gaia. It contains the
terrain data, the session itself, and all the creation and biome settings for that terrain.
Sessions are useful as they store the steps that were used to create a terrain and can be
used to re-create it later.

Installation Tips:

Before you start using Gaia, please ensure that Gaia is correctly configured for your
project.

While these instructions may seem long, most of the text here is informational, the actual
process is just a few clicks.

Create a new project in Unity or open the project that you want to use Gaia in.
Install Gaia from under Window > Package Manager.
If you purchased Gaia from Canopy, you will be able to download a .zip file from the

Canopy website download area. Unizip the file, and install the .unitypackage via Assets >
Import Package > Custom Package... in the Unity editor.
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After installing the Gaia Package, you will see the setup window itself:

Gala Setup

Welcome to Gaia!

I are agone

ace to Linear
Install And D
Install And D

Install And Delete Source

Installed:

Start Selected Actions

Gaia consists of multiple modules, each with its own installation package. You can choose
which modules to install on a project-by-project basis, to minimize disk space, build size
and processing time in Unity.

Unfold the package with the small triangle at the beginning of each line to learn what the
package does:

You can open this the Setup window at any time via Window > Procedural Worlds > Setup...
to install / uninstall additional components as you see fit.

It is also possible to delete the installer package to save disk space. Gaia will remember the
last choice you made, so that when a Gaia update arrives, updating already installed
packages only requires a single click.

Select the packages you would like to install by setting the dropdown on the right hand side
to “Install”. If you are unsure about the package selection, the default preset should be fine
to get you started. Make sure that the core “Gaia” package is selected - otherwise you will
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not be able to use Gaia.

Another setting to be aware of is the “Switch Color Space to Linear” setting on top of the
package list:

Install And Dele

You will see this setting only if your project is currently NOT configured to use Linear Color
Space. For most projects Linear is the better choice so Gaia offers to switch your project to
Linear BEFORE installation begins. This will save time by avoiding a second import process
if you switch later.

Click the “Start” button to begin the installation.

After installing Gaia, you can open the Gaia Manager Window from the Window Menu or by
pressing Control + G:

nux Standalone <DX11=

t Window Help

Lc Next Window Ctrl+Tab umm
Previous Window Ctrl+Shift+Tab B~ |icrarchy
Procedural Werlds ¥ Gaia ¥ Show Gaia Manager... Ctrl+G
PW Dev >

Show Discord, Have a Chat... Show Gaia Tutorials...
Layouts > Show Procedural Worlds Assets... Show Gaia Support, Lodge a Ticket...

Please Review Gaia...

Asset Store

Show Gaia Welcome...

Package Manager
Show Extensions...

TextMeshPro

General
Rendering
Animation

Audic

Sequencing
Analysis

Asset Management
2D
Al
XR

A

If the Gaia Manager Menu entry does not appear then you have a compilation issue with
your project. Please check your console for messages that might prevent the successful
compilation of your project. In a fresh project this will not happen, but in a larger project
these errors are often caused by conflicts with poorly coded assets. If you are stuck with a
compilation error you can’t resolve, then please contact support. Make sure that you
provide the error, Unity version, Gaia version, and the pipeline you are using.
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In the Gaia Manager, the Configuration tab will be opened automatically if further
configuration decisions are needed for your project.

You can see in the Project Settings list which configurations have been detected, and you
can choose to let Gaia automatically address them by clicking on the Fix button or to ignore
them by clicking on the Ignore button.

023.1.1111)

NOTE: The list of fixes will depend on the render pipeline used. Most configuration issues
are not a true error, but instead, informed guidance that can help your project to run
better.

For example, Gaia will warn you if post-processing is not installed in the built-in render
pipeline. But if you decide against using post-processing in your project, you do not need to

“Fix” this, but can click “Ignore” instead to hide the suggestion.

Every suggestion has a link to the Unity setting in question so that you can make informed
decisions about the configuration of your project.

If there are no issues (left) to fix, then you can start working with Gaia.
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To sum it up:

1. Import the Gaia package;
2. Choose the modules you want to install in the Setup window;
3. Open Gaia Manager and check for potential configuration issues.

OPTIONAL:
Gaia comes with its own water and vegetation shaders which also support the
i.e. URP and HDRP.

If you want to use one of these Pipelines, you need to set up Gaia for that specific pipeline.
If you want to use Unity’s built in rendering, you are done with setting up Gaia already.

Supporting these pipelines can be challenging for asset store developers as we need to
make sure that features like water use the correct shader for the current pipeline. To make
this easier for you, we have mostly automated this process in the Configuration Tab in the
Gaia Manager:

English

Builtin

+ Gaila Packages

+ Gaia Maintenance
+ News System
+ XR Support (Virtual / Augmented Reality)

+ D3D11 Swapchain Issue Information

In the Render panel you need to do only two things:

A) Select the pipeline you want to use and click the button to “upgrade Gaia to this pipeline”.
This will change the Gaia tools and functions to the respective pipeline. This process can be
reverted later as well.

B) After you configured the rendering pipeline, click the “Install Shaders” button. This will
install the shaders for the current pipeline. If the correct shaders are already installed, this
button will not appear.
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c5, Unity 2023.1.2f1) English

nfiguration
- 1. Configuration

- Render Pipeline

System Status:

ck To Built-In

+ Status
+ Gaia Packages

+ Gala Maintenance

amp Pac

, and much more.

The pipeline setup process is nhow done.

Please note: Using the SRPs is not recommended for Unity beginners as using those
pipelines come with their own challenges and limitations you need to master. Doing so
while just starting out with Unity will make your journey more difficult than it needs to be.

All materials you use beyond the Gaia vegetation items and the water need to be
compatible with your target pipeline. Gaia cannot set up materials from other asset packs
for you.

When you start building a scene in one pipeline and then switch to another, you might need
to re-apply Gaia runtime modules such as lighting or water because these usually contain
elements that are specific for the pipeline in question.

When you are switching pipelines it is possible to revert back to built-in rendering later and
then switch to another pipeline again.

Gaia & Gaia Pro 2023 by Procedural Worlds



Migrating from Gaia 2021

Gaia 2023 is not compatible with Gaia 2021, but you can migrate scenes that were created
with Gaia 2021into Gaia 2023.

Please visit this page to learn how to migrate your scenes from Gaia 2021:
https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-
articles/30_installation__getting_started/migrating-from-gaia-2021-to-gaia-2023-r160/
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Workflows

Gaia offers two “workflows” when creating a new word via Standard tab in Gaia Manager.

Stamper based gives you complete control over the process of terrain shaping, and World
Designer automates this for you.

Please run through both tutorials. Each adds different insights on the use of Gaia, and you
should be able to complete both in fifteen minutes or so.

Gaia tools and components

Before jumping into specific workflows, take a moment to review the tools that come with
Gaia. Many of these tools are optional and have been provided because they add value.

Gaia Manager

All workflows start with the Gaia Manager. To open Gaia Manager choose
Window/Procedural Worlds/Gaia/Show Gaia Manager..., or hit Ctrl + G.

Gaia Manager has four main tabs, Standard, Advanced, Extensions and Help:

o Standard: A process-based wizard for world creation.
e Advanced: Adhoc access to tools as you need them.

o Extensions: A legacy extension system.

¢ Help: Access to Gaia help and support.
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Standard Tab

Gaia Manager

Gaia Pro (4.0.0-c5, Unity 2022.3.0f1) -=DEV =- English

{Random Generation)

Create World Designer

Ippart forum, knowledge base library, tutorials, and much more.

The Standard tab acts as a wizard to guide you through the world creation process.

1. Configuration:

e Takes care of project configuration, shader installation, and material and asset
conversion for your pipeline.

2. Create World:
e Choose the size, platform, biome, and workflow for your world, and then create it.
The choices you make here help to optimize your environment for performance on

the selected target platform.

You can choose either stamper-based, world designer based or a hybrid of both for
terrain creation:

o Stamper allows full control with precise placement. You blend stamps
together to create exactly what you want.

o World Designer is fully procedural. You tell it what types of features you
want, and it uses this as a guide.

o World Designer and then Stamper. Create your world with World Designer,
and then go to Advanced Tab, and add a custom Stamper to refine it.
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3. Create Runtime (Optional):

¢ This step automates your scene’s runtime setup. It is provides handy configuration
for things like your player controller, skies, and water, and is completely optional.
Note that most runtime functionality needs to be installed from the Setup Window
before it appears in here!

4. Build and Deploy (Optional):

¢ This advanced step that can help with the configuration of your project for
deployment. It provides handy helpers for addressable and mmo server builds. This
step is not required for most people.

Advanced Tab

The Advanced Tab provides access to individual tools and utilities that you can use when
you need them.

For example, |
love this faceted
low poly style!

Gaia created the
scene, and the
Terrain Mesh
Converter
converted it toa
stylized low poly
mesh that would
be great for a

mobile game.

Meshes are more performant in some scenarios than Unity terrain and in particular should
be considered for mobile and VR based games.
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The biome shown here is the Synty biome, and the game play comes from our Rails
Shooter Pack.
System & Project Information

This panel shows information about your Unity project. It has a button that allows you to
copy these settings. Please use this when asking support questions in the Gaia Forums as it
helps us to understand what you are doing.

Gaia Terrains

This panel allows you to create a new terrain with either the stamper or the world designer
workflows.

Gaia Tools
This panel provides access to biomes, spawners and tools.
These include:

e Biomes / Spawners:

o Create new or Add existing Biomes
Biomes are collections of Spawners.

o Create new or Add existing Spawners
Biomes apply assets to your world via Spawners and can be masked so that
they only affect a small part of the world. Be wary when spawning over
manually placed assets, as they can be overwritten unless masked first. If
you are unsure, backup your project first!

e Gaia 15tamp Converter
A tool that allows the conversion and import of legacy stamps from Gaia 1.

e Location Manager
A tool that makes it easy to mark, and then move between locations in your scene.

e Mask Map Exporter
A powerful mask and mask visualization system that you can use to export masks

derived from your environment for use by other systems.

e Mass Edit Terrains
A tool to apply simple settings such as flattening to all the terrains in your scene.
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¢ Resource Helper
Can be used to apply resources from one terrain onto other terrains. Ensures that
all terrains in your scene are using common sets of assets. You would use this
when manually adding new terrain tiles to your scene.

e Scanner
Allows you to create new stamps from a wide range of sources. You can even scan
3D objects like walls and buildings and turn them into features that can be used to
influence your terrain.

e Session Manager
Links to the session manager in your scene. The session manager tracks all of the
operations that Gaia performs on your terrain. You can ‘play it back’ in fresh scenes
to re-create the terrain, and you can also enable and disable steps in the playback to
see or negate their impact.

e Stamper
Allows you to create a stamper to modify your terrain. The stamper has a visualizer
to see its effect, is maskable, and has many modes of operation. You can create
literally any shape you want with time and creativity. TIP: Your stamper remembers
everything you did to it, so if you get it into a mess, delete it, and add another one!

The stamps we provide with Gaia have been designed to be mixed and matched to
create an infinite number of possibilities. You can purchase more stamp packs from
Canopy.

e Terrain to Mesh Converter / Impostor Generator
This tool has many uses. You can use it to ‘crystalize’ a terrain and export it as a
low poly mesh that works well on mobile with assets from publishers like Synty, or
just as an export for a low poly mesh for mobile, VR and AR. You can also use the
impostor generator for your large worlds. This works with Gaia’s streaming system
and will load meshes in the distance instead of Unity terrains. This can deliver a
substantial performance improvement.

e Terrain Stitcher
When integrating terrains created by other tools, sometimes your terrain seams
will not match properly leading to cracks in the terrain meshes. This tool will do its
best to fix them for you. Be gentle though, it is not a miracle worker!
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Gaia Runtime

This panel automates the application of individual Gaia Runtime based components to your
scene. These are all optional, and can be a handy time saver.

Most of the runtime components can be installed as separate modules, so you can install
only the components you really want into your project to keep the file size low.

Help Tab

The help tab provides handy links to the support forums and documentation on Canopy.
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Create a terrain using the stamp-based workflow (manual generation)
In this scenario we will use Gaia to generate a new world using stamps and a biome preset.
1. Create a new scene, File -> New Scene

4 Unity 2019.1.0f2 Personal - Untitled - GaiaD
File Edit Assets GameObject Compone

MNew Scene Ctrl+MN
Open Scene Ctrl+0
Save Ctrl+5
Save As... Ctrl+Shift+5

Mew Project...
Open Project...

Save Project

Build Settings... Ctrl+Shift+B
Build And Run Ctrl+B
Exit

2. Open the Gaia Manager, Window/Procedural Worlds/Gaia/Show Gaia Manager...

English

Norld Designer

Free St

d much more.
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3. Choose your World Size, Target Platform, Target Biome, and Workflow.

ate World

e World Size is the size of your world. For now, leave this at the default setting.

e Target Platform is what you are targeting your world to run on. Gaia will use
this as a guide for how it sets up your scene.

o Target Biome is the Biome that will apply to your world. Gaia Pro provides a
more biomes to use, and you can also create your own.

e Workflow is the world creation workflow that you will use. In this case we are
creating new world with a stamper.

If you are curious, you can click the small “+” buttons to see the detailed world size
and quality options. These options impact how the world is created, and you should
leave these at their default settings unless you are an advanced user.

4. Select the “Manual with Stamper” workflow, then click on “Create Terrain(s)” to create
the terrain and set up a stamper tool.

Important: Depending on your Gaia version and which additional modules you have
installed, you will have different options available in the Biome selection dropdown. The
screenshots made in this tutorial were made with the “Alpine Meadow Biome” which is
part of Gaia Pro, but you can choose the “Gaia Pro Sample Biome” if you do not own the
Pro version of Gaia. The biome selection will not influence the overall workflow, but
only which textures, assets, etc. will be applied to your terrains.

Depending you your pipeline, Gaia will also ask you to set up your lighting. Select Yes.
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Gaia Manager

It looks like you are starting with a new terrain and
HDRP lighting is not setup in your scene. Would you like

to setup defauit HORP lghting suitable for editing your
terrain?

4k Hills 2

Cancel

5. Gaia just did a huge amont amount of work for you! Lets unpack this by taking a look at
the scene hierarchy.

=

Environment Volume

There are three main object groups:

Gaia Tools

- These are the tools that Gaia uses to do work on your scene. The Session Manager
tracks all the operations performed, The Alpine Meadow Biome controls the spawners
that add it into your scene, and the Stamper which is used to shape your terrain.

Gaia Runtime

- These are helpers for Gaia runtime operations. You can see the lighting that you just
added by selecting Yes in the previous step.
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Gaia Terrains
- This is the terrain that Gaia created and added to your scene.

6. Back in the main area of the scene we have the following components.

Manager

4k Hills 2

The blue-greenish image you see in the scene view is a low fidelity preview of the
terrain shape we are about to create. You can see the terrain we created under it.

You will also see a stamp browser window which allows you to select a stamp (“terrain
shapes”) that come with Gaia.

Important: If you did not install the stamp package as part of the setup process, you
will not see any stamps in this window. In this case you can go to Window > Procedural
Worlds > Setup... to install the stamp package now. You can refresh the stamp browser

by closing it and clicking on the “Stamps...” button in the stamper.

For simplicity close Gaia Manager for now so that we can focus on the stamper.
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7. We have a preview world in green, the Stamp Browser in red, and a stamper
component has been created under Gaia Tools in your scene hierarchy.

The Stamper is a tool that applies stamps into your scene. It shows a low fidelity mesh
preview in real time.

You can also see the ‘sea level’ as a blue plane to give you a guide on where the water
would be in your scene.

wse

- Select Stamp

4k Hills 2

+~  Hills
Islands
Masks

Mesas.

Mountains
Plains
Rivers

Valleys

8. Selected the Island drop down and then use the right and left arrows on the Stamp
Browser to preview different stamps.
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The preview updates, and you can see that the edges of the stamp would now be under
water.

The lighter section of the stamp preview represents high points on the terrain, and
darker areas represent low points on the generated terrain. You can see this reflected

in the preview.

Click the Apply button to select that stamp.
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9. The Stamper is now selected. Click the “Stamp” button to stamp your terrain!

8 Inspector

ij «  Stamper

-
Tag Untagged Layer Default

= Transform
Position

Rotation

ﬂ ~+ Stamper (Script)

- Dperation Settings (4.0.0)
Stamping/Raise Height b
Stamps...

Operation Type
Stamp Image 2k Island 1 =
strength Transform [nvert
tamp Space Local
Stamp Offset f Position X0
Stamp Scale X1

Stamp Rotation
Sea Level

Mask Settings [1]

Distance Mask HEM x

Influence Global
Strength Transform Irvert
Distance Mask Curve
Axes ®Z Circle
Mask Space Local Tiling
Offset [ Position X 0 0
7 1

Scale X 1 z

Raotation

Flatten Ground

Fit Ta Terrain Fit To Warld

+ Advanced

+ Record Undo Operations: 00

Preview
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10. Gaia has now applied the stamp into your terrain and textured it as welll

Manager v Layer Default

Flatten Ground
Fit To Terain Fit To World

+ Advanced

v Record Undo n Undo

Stamp

Spawn Biome

So what just happened?

Gaia used the Stampers “Stamping / Raise Height” Operation to apply that stamp to the
scene, and then called the Alpine Meadows - Textures spawner in the Alpine Meadow
Biome to texture it for you.

File Edt Ascls GemeObject Component Services Jobs Wiindow _Help

Add New Rule

Auto texturing is a handy short cut that gives you a sense of how your scene will
eventually look. As you become more proficient with Gaia over time, you can customize
these Biomes or create new ones to create your own look.

Gaia & Gaia Pro 2023 by Procedural Worlds



Lets add another stamp to customize your scene further.

Make sure that your Stamper is selected in the hierarchy, and click on the Stamps button to
open the stamp browser.

n v Stamper (Script)

- Operation Settings (4.0.0)

Stamps...

Invert

2K Island 1 Invert

Islands

Apply Cancel

Flatten Ground
Fit To Terrain Fit Te World

+ Advanced

cord Undo O 11 Undo
Preview Stamp

wi Biome
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Browse to Mountains, and hit the arrow buttons to select 2k Mountain 4. Notice how
the blue/green preview updates in the background. Hit the Apply button to select it.

¢ Brm mr @ ¢

Manaaer

® | Stamps.

Invert

Flatten Ground
Fit To Terrain Fit ToWorld

Make sure that the Mover tool is selected, and then both lift the Stamp preview, and then
drag it to the left. Notice how the stamp is sitting well above the underlying terrain.

Manaager -
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Next select the scale tool to make the Stamp smaller and higher.

ERELE
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And now hit the stamp button.

v Stamper
Manager Untagged

Transform

B - stamper (Seript)

- Operation Settings (4.0.0)

BE® x
Global -

Invert

Flatten
Fit Ta Terrain

+ Advanced

« Record Undo Operations: 1/1

Spawn Biome
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Awesome. Gaia added and textured the stamp, but.. Houston we have a problem! There
is a very ugly big step between the existing terrain and the new stamp.

To fix it hit the Undo button. This will undo your last operation.

Warning: The Undo list will be lost if you hit play!

Manaaer

tamper (Script)

tion Settings (4.0.0)

Flatien
FitTo Terrain
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11. Now lets use a mask to fix this issue! Gaia has an incredibly powerful masking system
and you can use these to get many sorts of effects. By default, the stamper is already
set up with a distance mask that will help us to fix this issue. You can find it in the Mask
Settings of the Stamper, and activate it with this checkbox:

« Stamper (Script)
- Operation Settings (4.0.0)
Operation Type Stamping/Raise Height
Stamps...

Invert

Sea Level

Mask Settings [1]

Distance Mask

Influence Global

Flatten Ground
Fit To Terrain Fit To World

+ Advanced

rd Undo Operations: 2/2 Undo
Preview Stamp

Spawn Biome

The distance mask fades out the stamp towards the border of the stamper. With the
default settings in this mask, the stamp will be blended out in a circle shape towards the
border of the stamp. You can already see how there is a better transition to the
surrounding terrain:
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Manager

Flatten
Fit To Terrain

Spawn Biome

We now have a problem because the stamp’s scale does not work well. We need to change
this to make it look more natural.
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12. Use the Mover and Scaler tools, and adjust the position and scale of the stamp. If you
accidently unselect the stamper, just select it again in the hierarchy to get the preview
back. You can see how the Distance mask blends the stamp nicely into my scene.

When you are ready, hit the Stamp button!

g @ v B mvy G-

*‘:;-.
it

Manager

Tip: You can also use the rotation tool to rotate the stamp as well!
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13. Turn the preview off to see your work, and then turn it on again.

Manager

® | Stampe.

" lnvert

Flatten
Fit To Temain

Notice that the texture operation is only called in the context of where the stamp
currently is.

14. To fix this, click on the Alpine Meadow-Texures object and hit the Spawn Local button.

ity 20223.11° <DX11>
Jobs _Mobile Inp

Nice. Now we have re-textured the terrain, and it looks pretty good!
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15. Lets get a sense of how this looks ‘in game’.

Click on the Manager button at the top of your Scene view to open Gaia Manager up.

@ Gaiz HDRP Demo - Untitled - Windows, Mac, Linux - Unity 2022.3.1F1% <DX11> = o X

File Edit Assets GameObject Component Services Jobs Mobilelnput Window Help

(e

Manager d v Layer Default

It should automatically select the runtime tab since you already executed the first two
steps of the scene creation process.

Gaia Pro (4.0.0-c5, Unity 2023.1.2f1)

- 3. Create Runtime (Optional)

# Lighting Pres

s Utilities

v Water

v Controller Setup

<< Back To World Creation

This tab shows you the available runtime elements such as Lighting or Water that you
can add to your scene. Unlike the Gaia Tools, these elements are intended to remain in
your final product. You can take a look at the available modules and choose what you
want to add to your scene. It is possible to include / exclude modules with the
checkbox in front of their name. Modules can have additional settings that you can
modify before bringing them into the scene. Click on the small “+” in front of the name
to show these options.

Remove Apply

If you are missing modules, note that you can install them from the Setup Window via
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Window > Procedural Worlds > Setup...

Open Gala Manager

For the sake of the tutorial it is recommended to install the water and lighting preset
modules in the project, as they make a huge visual impact in the scene.

You should also have the “Controller Setup” package installed to be able to explore the
scene during runtime.

Click on “Create Runtime” to add the elements to the scene.

16. We now have skies, water, post fx, audio fx, a screen shotter and a player controller in
our scene!

Add New Rule

You can see these in your screen hierarchy under Gaia Runtime. We did a lot of work for
you and this is a big time saver!
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For new scenes this appoach makes it easy to prototype, and check its scale. You can
remove the runtime later.
17. Hit Play and enjoy your scene!

Notice that we created a runtime user interface down at the bottom left of your screen.
Read this to learn how to control the Fly Camera we put into your scene.

Ui: U (toggle user interface)

&
the Location Manager from the Advanced Tab In the Gaia Manager to bookmark interesting iocafinns: LeftShift + B (new Bookmark)_ LeftShift +
LaftArrow/ RightAsrow {cyole bookmarks} ?
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18. Ok, last demonstation of the stamper before we finish this world.

Choose one of the Effects Operations. In this case | am going to choose Effects / PRO
Terraces. This is a Gaia Pro feature.

The preview will update to give you a sense of how this effect would be applied to your
scene. You can move and scale the stamp to contol its area of effect. You can also
influence this with masking.

@ Gaia HDRP Demo - Untited - Windows, Mac, Linue - Unity 20223111 <DX11> - o x

Flatten
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19. Experiment with your settings and then hit the Stamp button.
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20.Neat... but these terraces are a bit extreme... we could fix this with Gaia... but part of
the power of Gaia is that you can mix and match.

Lets use the Unity terrain itself to soften this. Paint the effect you want directly onto
the terrain!

@ Geia HORP Demo - Untiled - Windows, Mac Linuc - Unity 20223.1#1° <K11>

File Edit Assets GameObject Component Services Jobs MobieInput Window Help

The masking and stamping system in Gaia is extremely powerful for more information
please check out the following links.

Tutorial overview

How to create your own stamps with the Scanner
Stamper Introduction : How to use the Stamper
How to mix and blend stamps

Introduction to masks
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https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/gaia-pro-2023-tutorials-overview-r169/
https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-articles/advanced/gaia-scanner-r66/
https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-articles/creating_your_world/2-stamper-introduction-r46/
https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-articles/creating_your_world/3-how-to-mix-and-blend-stamps-on-an-existing-terrain-r47/
https://canopy.procedural-worlds.com/library/tools/gaia-pro-2021/written-articles/populating_your_world/3-introduction-to-masks-r50/

21. Lets spawn the biome!

Select the Biome (which you chose earlier when creating the terrain), and then hit the
Spawn Biome button!

Depending on the speed of your machine you will need to wait a bit. On my machine
with this demo, it took about 2 seconds.

@ Gain HORP - <oxi1»
leInput Window _Help
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22. And now hit play and go exploring!

Ul: U ftoggle user interface)
the Location Manager from the Advanced Tab in the Gaia Manager to bookmark inferesting iocations: LeftSRift + B {new bookmar, Left:
irow, feycle bookmarksh

Open the L.
LeftAsow / RightAsow

23. For a different look to the game, stop the game, and re-visit the runtime tab in the Gaia
Manager. You can pick a different Lighting preset here, e.g. “Morning”.

Remove Apply

You can choose to re-apply individual modules or the entire runtime setup as a whole.
Here is how your scene might look with Morning Lighting:
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ELELE

24. To further refine the environment, remove all of the assets using the biome controller,
so that you can then get in with the Stamper to do more work.

Select the object types you want removed and hit the Clear Spawns button. You can
then use the stamper to refine your world.

You can run the Biome again at any time.

Warning: The biome system will overwrite what is in your scene so please treat it with
care. If you have done some manual texturing or vegetation placement, it will be lost!
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25. You can also enable and disable individual asset types in the Biome before spawning it
again.

roller (Script)

(3:3.8)

@ Gaia HDRP Demo - Untitled - Windows, Mac, Linux - Unity 2022.3.1f1% <DX11> - o x

File Edit Assets GameObject Compone es Jobs Mobile lnput Window Help

il -

Manaaer

Add New Rule

The Biome and Spawner system in Gaia is quite deep. Its is well worth your time to
work out how to use it to get the look you want.

This concludes the Gaia Quickstart Guide for the manual workflow using the Gaia Stamper.

Please read on further below for a guide detailing the World Designer (Random Terrain
Generation) workflow.
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Create a terrain using the world designer workflow (random generation)

The previous section explained the how to create a terrain manually using the Stamper.

The World Designer replaces the Stamp workflow with an automated approach to terrain
generation.

It's a great way to rapidly iterate on environments, especially larger ones, and you can
refine them further manually with a Stamper after they have been generated.

The previous stamper workflow showcased how to blend stamps, and some of the
features of the runtime system. Please complete that section before this one.

1. Open a new scene and bring up the Gaia Manager again. The default settings will be fine,
but this time we will switch the workflow to “World Designer (Random Generation)”

English

mnla

(Random Generation)

Free Stamp Pa
R

2. Click the “Create World Designer” button. Gaia will open the world designer tool for you
and will show you a terrain preview that matches the world size.

© Gaia HORP Demo - Untied - Windows, Mac, Linux - Unity 2022.3111° <DXT1» = m

Assets  GameObject  C Seni Mobile Input  Window Help

Manager

The current preview isa 1:
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3. The terrain shape is randomized, so your terrain will look different. The easiest way to
use the world designer is to click the “Randomize All” Button. Clicking this will cause a
new terrain will be generated.

cene o8 Game

[Blcenter» [Plocal v

Wanaaer

Randomize Stamps
Clear Stam

4. When you see a terrain shape that you like, press the “Generate World” button, and
confirm the popup.

~ World Designer (Script)
- World Settings

- World Size and Biome - 1.02 km size, Terrains: 1

+ World Shape

+ World Detail

+ Preview Settings

+ Advanced
Random Ps Randomize Al
Reset To Defaults

Generate World
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5. Gaia will now take the preview shape and create a unity terrain and spawn the textures
from the selected biome:

@ Gaiz HDRP Dema - Untitied - Windows, Mac, Linux - Unity 2022.3,1f1% <DX11> - o x
File Edit Assets GameObject Component Services Jobs Mobilelnput Window Help
e v -

Hierar

g5

v Alpine Mead
Tag Un

2 Untitled* Manager

Fit To World

a: [ World

e

a & Create N e Setupin Stamper

+ Advanced

+Clear Spawns,

Add Component

M Packag:
@ Finishe
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6. From here you can click the Spawn Biome button in the Biome Controller. It seems that
it did not do the entire terrain, but this is incorrect. Gaia use layer-based culling in order
to improve performance. Moving in closer will show all the content.

in
~n =~

i

< Parsp

7. Bring the Gaia Manager back and Update your runtime. You can see that the visuals
have been updated.
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Manaager Show Desianer

v:

G, s Fabiia
lrjﬁshiﬁ +LeftArrow/ RightArrow (cycle bookmarks)™

9. Let’s explore World Designer in more detail. Create a new scene and choose the World
Designer workflow from Gaia Manager.

Hit the clear stamps button so that we are left with a base terrain. Then open the World

Shape panel and select “Generator” and “Water” and adjust the settings that influence
the base shape of the terrain.
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The most important settings are:

Shape Input type - Allows you to switch between generating a shape from Noise
(Generator), using an input image or an already existing terrain.

Border Style - Allows you to force the borders of your world to be Water (to create
islands), Mountains or nothing specific.

Height Scale - Influences the overall height of the base terrain but also of the stamps
that are placed on it.

Base height - lifts the entire shape up on the y-axis.

You can find more information about all the remaining settings by clicking the “?” icon in
the World Shape Panel.
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10. Try to create a more interesting base terrain shape that would still be somewhat
recognizable when the stamps are spawned.

w Er B omr§

Gaia Show Terrain
-t g

* Layer Default

Z (m)

1. Next we will look at the World Detail settings which control the stamp spawning.

- World Settings

+ World and Biome - 1.02 km
+ World Shape

- World Detail

) Valleys [ Lakes

¥ (0) Mesas

¥ (0) Hills

} Mountains

v (0) Islands

v (0) Rivers

Add New Rule

There are 4 general settings on the top that apply to the way the stamps are being
spawned on the base terrain:
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Stamp Density: Controls the number of stamps that will be placed on the terrain. You
can drag the slider around to see a preview visualization of the stamp areas (each circle
represents one stamp that will be placed). There is also a checkbox in the scene view
panel to activate this visualization permanently.

Manaaer Show Terrain |2/

n

Stamp litter — controls the randomness in stamp placement - at a Jitter of O the
stamps will be placed in a grid-like fashion, at 100 they are shuffled around in position
to make that pattern less recognizable.

Stamp Width - controls the width of the stamps that are being placed. Again, the
visualization in form of the blue circles pops in when you change the value here so you
can review the stamp sizes and positioning.

Stamp Impact - Controls how much Impact on the base terrain shape the stamps will
have - A high impact means that the imprint of a mountain will be rather high, and the
imprint of a valley would be rather deep. High Impact means that the stamp features
are more visible which can make the terrain more visually impressive, but it is also
possible to overdo it so that the stamps become unnaturally distorted.

These settings can have a huge impact on your final result, and “more” does not
necessarily mean “better” for these settings.
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For example, here is a generation result with high stamp density, high width and high

impact:

# Scene
Shaded

M D IR

kel

Manager

Show Terr;

[ ] J<]<]<]

A —

- e wle-lwo 5 -

Manager_
\

Show Terrain_|?]

Y a

X

Medium
Desktop

Alpine Meadow
765507448

World Size
Target Platform
Target Biome
Random Seed
Sea Level

- World Detail

Stamp Density
Stamp Jitter
Stamp Width
Stamp Impact

|+ 7 (0)Plains

+ 7 (0) Valleys / Lakes

‘ + v (0) Mesas

[+~ () His

‘ + v (0) Mountains

[+ 7 (0 Istands

L ([l [l el [l el ([«
IR EE R R E)

DyDjofDyoyoy

‘o?(o)m-n

© Inspector
Target Biome

Random Seed
SeaLevel

Alpine Meadow
701344323

|+ Workd Shape
- World Detail

Stamp Density
Stamp Jitter
Stamp Width
Stamp Impact

|+ 7 (12)Plains —e— sviell/s X

|+ 7 (D Valleys /Lakes ———@— a|v © g

‘ . v (15) Mesas

4 (@) Hins

|+ (22) Mountains

\ + v (10) Islands

oloioiojo

[+ < (MRivers

Add New Rule

- Preview Settings

Not a very good result - this happens because too many stamps are placed on top of
each other and overlapping multiple times. The result is an unrealistic mountain with

barely recognizable features.

Gaia & Gaia Pro 2023 by Procedural Worlds



The other extreme is too little, too small, and the stamps will not overlap with each
other:

# Scene © Inspecter

Shaced ([0 ¢ w2~ o[- % m-iGhmoslw| Al | || Tagergiome Alpine Meadow
Manaaer Gaia Show Terrain_ 2/ Random Seed 701344323
e - &3

Sea Level

+ World Shape

- World Detail

Stamp Density
Stamp Jitter —_—
Stamp Width ———————————— |51
Stamp Impact —————————

S —

+ /| (0)Valleys/Lakes ———@— a|v|® s X |

[+ 7 (0) Mesas = OdQE]|

[+ 7 (0 Hins —e — av/eoms X|

[+ 7 (O)Mountains @ — +v cElS X

4+ < (0) Islands —e—— avisls x|

[+ 7 (0)Rivers e av omms X|
102 Add New Rule

- Preview Settings

# Scene © Inspector

Shases _—

Y. & 7 Tag | Untagged ~ | Layer Default ~

v # ~ World Designer (Script)

- World Settings
- World Size and Biome - 1,02 km sq, Terrains: 1
World Size Medium
Target Platform Desktop

Target Biome: Apine Meadow
Random Seed 1637090785

Sea Level

+ World Shape

- World Detail

Stamp Density *—— 3
Stamp Jitter —_— 25
Stamp Width -5
Stamp Impact — e 100

|+ < (3)Plains ——e— Avioms X

|+ 7 (@) valleys/Lakes —— @ | /v|® s X |

|+ 7 () Mesas — e alveo] » X

Again, not a good result - the featureless base terrain is mostly visible, and the stamps
are not connecting to a cohesive landscape.
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What you should aim for is that the stamps are overlapping a bit, and that individual
stamps have enough room to imprint their own features on the terrain:

# Scene

O Inspector

Shaded |m|nmm 20|y |~ % |mt~|Gizmos |+ (Al | ) | WordDesigner O state~
I Manacer Gaia Show Terrain -
e ———a— Tag Untagged ~| Layer Default -
] =
—. i88 v # v World Designer (Script) e
- World Settings 2]
- World Size and Biome - 1,02 km g, Terrains: 1 B
World Size: Medum vl
Target Platform Desktop |+
Target Biome Alpine Meadow (%)
Random Seed 923117551 New Auto |~/
Sea Level -———— 5
+ World Shape 7]
—
H ~ World Detail H
Stamp Density B — P
Stamp Jitter —e——————— 5
Stamp Width —e——————— 10
Stamp Impact — e o
—
X s —
¢ 7 (O)Valleys/Lakes —— @ A Y ®  p X
[+ 7 (0) Mesas —e — alvi=| s x|
< (s alv]= x]|
# Scene | omGame et Sto Inspector 3
<he < ny ee im0l - % | s "m  mgo_ o
Manacer Show Terrain 17 . — —
T [+ 7 (5)Hills — e avomEs X/
[+ /| @Mountains —— @ a/v o Bls X/
+ 7 (4)Islands —e— alvlollis X/
|+ v (4)Rivers —e — av oEls X
Add New Rule
- Preview Settings fd
Draw Preview =
Stamp Density / Width L
[ | semplescale objects =2
Sample Object Handles L]
=

Size Graph

T current praviow s 3 11 raprosentation of what wil be ganerated i terme of
1 resolution and size. If the worki designer can't display a 1:1 reprasentation due to
the size J resolution, you wil find aditional options here ta control the preview. |

 + Advanced H H

Stamps Randomize All |
Clear Stamps Reset To Defaults |

Add Component

This is a better result - the individual stamps are connected but have still enough
“breathing room” to display the actual features of the stamp.

World size, the total available heightmap resolution and scale also play into this.

If you are creating a multi-terrain scene with 10 x 10 terrains with a heightmap
resolution of 1024 x 1024 meters each, this is a lot more space, and total heightmap
resolution requirement is vastly more than for a single terrain.

To avoid losing features due to the limitations imposed by lack of stamp resolution, you
would use more stamps to fill this space.
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12. Following the stamp spawning settings are the individual entries for the different
classes of stamps that the world designer can use during generation:

- World Settings

+ World Size and Biome - 1.02 km size, Terrains: 1

+ World Shape

Add New Rule

You can activate these features with the checkboxes, and you can change the relative
distribution with the sliders (left = less, right = more).

Like the spawn rules in a regular Gaia Spawner, you can unfold each of these rules to
display more settings for how and where these stamps will appear on the base terrain:

- « (0) Plains
EIE
Plains

The feature type is the class of stamp that will be chosen. This selection is linked to the
Gaia Stamps directory, and if you add your own stamps, they can be used as well.
The main settings are:

Spawn probability - This is the same slider as in the list display and influences the
overall chance that a stamp of this feature type will be selected.

Height probability - how the height of the base terrain will influence the chance of the
stamp to appear (left side of the curve = minimum height, right side = maximum height)

Stamp Height Modifier — controls how the underlying height of the base terrain at the
spawn spot will influence the height of the spawned stamp. For example, if a mountain

Gaia & Gaia Pro 2023 by Procedural Worlds



13.

stamp would be drawn for spawning at a beach, it should receive only reduced height to
not fully destroy the underlying base terrain shape.

Invert Chance - Chance the stamp will spawn inverted (a valley instead of a mountain)

Width Range - the possible width for the stamp when spawning (100 = one full terrain
wide)

Mix Height Strength - Stamps are spawned using the “Mix Height” operation to blend in
well with the already existing stamps. This slider controls the minimum and maximum
strength for this operation according to the Stamp Height Modifier above)

Mix Height Midpoint — another setting from the “Mix Height” operation. This setting
controls whether the features found on the stamp should be elevated above the
terrain, or rather should cut down into the terrain.

The more the slider range is to the left, the more this operation will use the stamp to
elevate features above the terrain (Which you would want for mountain-like stamps)
The more it is set to the left, the more it uses the features in the stamp to lower the
terrain (Better for valleys, rivers, lakes).

With the base shape and the stamp spawning settings all set up, we can look at the
controls for the World Designer that start the stamp spawning process:

+ Advanced

Randomize Stamps Randomize All

Clear Stamps Reset To Defaults

Generate World

“Randomize Stamps” will keep your base shape and will spawn stamps according to the
stamp probabilities you set up. This is the button to use to generate a terrain that sticks
to the base shape and where you can try out how it will look like e.g., if you decide to
increase the mountain probability.

“Randomize All” will create a random base shape and will also randomize the stamp
probabilities. This button is suitable if you want a mostly random terrain. (This is the
button we used earlier in the guide to create the completely random terrain)

“Clear Stamps” will clear all spawned stamps so you can see the base terrain shape

again.

“Reset To Defaults” will reset the Settings to sensible defaults according to your
selected World size.

“Generate World” will turn the currently viewed preview into a real unity terrain. After
the generation you can treat this terrain like a terrain that you shaped manually with
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the Gaia stamper.

14. To complete your terrain generation on a base terrain, click the “Randomize Stamps”
button. You will see stamps appear on the base terrain that you created initially.

# Scene | o Gam | Asset Store . @ Inspector
Shaded >

- World Shape

Shape Input Type Generator

Border Style Water

Height Scale . 7 ]
Base Height *e—— 0

Noise Style Petlin

Strength ———— e ————— 0502 |
Steepness —_—————8— 0843
Offset X0 Y0 zZ0

Feature Size _— & 962 |
Granularity ——— 8 ——————— 15
‘Warp lterations 0

Warp Strength . A——h]

Warp Offset

EEQEQn

= World Detail

Stamp Density
Stamp Jitter
Stamp Width
Stamp Impact

4~ (0)Plains

} + ~ (0) Valleys / Lakes

+ ~ (0) Mesas

L L[] ]<]

15. The last thing to do when you have a terrain shape you are happy with, is to click the
Generate World button. Gaia will warn you that it will remove all existing terrains from
the scene to export your new terrains.

Pro Tip: The settings for the World Designer can be saved and loaded again via the
“Advanced” Panel. In this way you can quickly apply the same generation settings in
different scenes or projects.
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How to create stylized low poly terrains — cool technique

In this mini tutorial | am going to create a terrain. | could be made with any technique you
want. Here | will use the world designer.

1. A nice randomized terrain.

Qv 22 ¢ & gv @

Manager

Add New Rule

2. Generate my world.

i = Qr = | ¢

o~ — T
. TN e (“‘M‘ L= Y A Transform
- |

Position

troller (Script)
(338)

Alpine Me

Fit To Terrain

<! mAlpine

Setupin Stamper
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3. Now - let’s do some magic! Open the Terrain to Mesh Converter!

Gaia Manager

Gaia Pro (3.3. .3.111) English

+ Gala Terrains

- Gaia Tools

Converter
Location Manager
Kk Map Exporter
s Edit Terrains

e Helper

Stamper
Terrain to M

Terrain Stitcher

+ Gaia Runtime

library, tutorials, and much more.

Terrain (

- Sou

Load

enth

Low Poly

Add LOD Level
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4. And then hit Start Conversion!

Manager Show Designer

5. Super cool! You successfully converted your terrain into a low-poly scene! This is an
entire separate asset worth of work right here!
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Creating larger world sizes in World Designer

In theory there is no size limit in the world designer - if you increase the amount of terrain
tiles in the world size settings you could generate very large worlds with it. In reality we
are constrained by the limitations of memory and the Unity terrain system.

To assist you when creating large worlds, the world designer displays extra controls in the
scene view:

e When working with multiple terrains, the world designer will only display the stamp
spawn result on a single terrain tile like so:

# Scene
Shaded

|
]

Render Full Preview

|

Zoom In

eview resolltion. Zoom intoview single terraifitiles at 11 reso/ution.

This is done to keep the preview responsive because large terrains with 100’s of
stamps take time to calculate.

You can preview other terrain tiles by changing the X/Z tile coordinate in the panel in
the scene view, or by dragging the white box cursor around. The preview will update to

the new spot after 2 seconds.

To see the full preview, you click the “Render Full Preview” button. This will take some
time but will display a full preview when finished.
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The preview can only display a total resolution of 4097 heightmap pixels for technical /
performance reasons.

This means that you can create a world that can have a much higher terrain heightmap
resolution than what is currently displayed in the preview.

The scale and size of the preview will still match with what is generated, but you would
not see every detail in the preview due to the lower resolution.

If you want to look at the actual resolution of a single terrain tile, you can do so with
the “Zoom In” button.

This will Zoom in the preview to a single terrain tile which is then rendered at the
correct heightmap resolution.

# Scone | GBGame )

L]
L]
2

Render Full Preview

= e}

When looking at the preview, it can be difficult to estimate the scale of the resulting
terrain correctly.

A small world can take in the same amount of screen space than a large world
depending on how far you are zoomed in.

Then when generating the world you discover that the world offer too little or too
much space or your mountains are much smaller than you expected from the
perspective of the player.

To combat this, the world designer features a size graph at the borders of the preview.
The numbers printed on here are world space unity units / meters measured from the

center of the world at X=0 / Z=0.

This helps you to understand how much space there would be in a certain area.
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If you scroll in to the center of the preview, you will also notice that there are a some
sample objects being rendered in the scene.

These help you to estimate the scale of the terrain features. This mountain ridge might
seem massive at first glance:

4R EMENETR X |m~ Gizmos [~ llea |
| Manager | Gaia Show Terrain | ?/] v

x ‘ z
A

With the sample scale objects, we can see that the character could scale this ridge
quite quickly.

' O DECOEE I T —
Manager | ala Show Terrain | 2 f  a
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You can activate handles for these objects in the scene view settings panel, this allows
you to drag around these objects on the preview to test different locations for scaling.

This concludes the introduction to the World Designer. You can learn more about the world
designer in the built-in help features of Gaia, including the link to the online manual page for
the World Designer.
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How Gaia organizes your scene hierarchy

When you create a world Gaia adds Gaia Tools, Gaia Runtime, and Gaia Terrains to your
scene hierarchy.

¢ Gaia Tools are the tools that uses to modify your scene. You can delete them
before you make your final build, and add them back again as needed from the
Advanced Tab.

¢ Gaia Runtime contains helpers and runtime modules that need to be present during
runtime of the scene. Most of these are being added from the “Create Runtime” tab
in the Gaia Manager, and can be removed from there as well.

¢ Gaia Terrains is where Gaia puts the environment it is generating for you. If you have
Gaia Pro and enable streaming, then Gaia will create each terrain in a separate
streamable scene for you and manage the process of loading and culling these
scenes at runtime.

o Tip: You can use the Terrain Mesh Exporter in the Advanced tab to create
terrain impostors for large streaming scenes. Gaia will display these in the
distance rather than the original terrains, and this can have a significant
impact on performance.
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Customizing Biomes and Spawners

You probably noticed during the creation of your first worlds with Gaia, that tools like a
biome controller and spawners are added to your scene:

e A Spawner is a tool that spawns resources on your terrain, including terrain

textures, trees, terrain details (grass) and objects.

Each resource is represented by a "Spawn Rule" in the spawner that determines
what is spawned and where it is spawned to.

¢ Multiple spawners can be grouped into a biome so that a set of matching assets can
be spawned together.

The biome controller is the tool that collects spawners and makes them spawn

together at command. It is possible to spawn this set across the entire world, orina
restricted area of your world so you can have multiple biomes in your world.

You do not need to stick to the art assets that come with Gaia / Gaia Pro. You can fully
customize the biomes, and / or create your own biome from scratch.
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Swapping out art assets

To swap out art assets on an existing spawner, select the spawner and check for the
"Spawn Rules" section.

Each spawn rule represents one resource that is being spawned on the terrain. By opening
the resource settings, you can see the prefab / texture etc. that is used in this rule.

Unfold the Spawn Rule to
see its settings, then open
the resource settings to
expose the used resource
for this rule

You can swap out the used asset by selecting a different prefab / texture etc. Gaia will
automatically swap out the resource on the terrain and use the new asset now in this
scene.

Changes that you make this way will only affect your current scene, but it is possible to
save the spawner settings into a file (see under Advanced: Save & Load in the spawner) so
you can re-use the settings in other scenes.
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Customizing where assets spawn

To influence where Art Assets spawn on the terrain, you need to get familiar with the Mask
System in Gaia. By default, an unmasked spawn rule will just spawn anywhere on the
terrain. This means that a tree spawned by this rule would appear under water, over water,
on steep slopes, etc.

By adding masks to the spawn rules, you can combine multiple restrictions to spawn your
assets in a more logical fashion, e.g. adding a height mask ("Do only spawn over water")
with a slope mask ("Do only spawn on flat areas”) to get better results for your spawning.

It is possible to set masks on the spawner or at the biome level as well to influence
multiple rules with a single mask.

To edit a spawn rule's mask, open the spawn rule and look at the mask settings. If you click
the eye icon, you can see a visualization of the currently active masks for this rule:

The eye icon shows the result
of the current masking on the
terrain

Activate and deactivate masks

and adjust the settings to watch

the visualization to adjust in real
time

You can then add or remove masks to get the spawn rule to spawn where you want it to.

Remember there might also be masks on top of the spawner or in the biome controller that
could also influence the spawn rule.

For a full description of the available masks, their effects and their settings please see this
article: Introduction to masks
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Building a Biome from scratch

You can build new biomes and spawner from scratch and use them in other projects and
scenes. We created a tutorial series for this that goes both in the technical details as well
as some design aspects of creating a full biome.

Please see this video tutorial series if you are interested in building your own biome:

Biomes and Spawners - Intro and Installation

Biomes and Spawners - Texture Spawners

Biomes and Spawners - Game Object Spawners

Biomes And Spawners - Trees and Grass, Biome Creation
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https://www.youtube.com/watch?v=_F6YJ-pbdsY&list=PLckEMv5tz0E5zWRpjwnHX6a6nFSTcpWD2&index=17&pp=iAQB
https://www.youtube.com/watch?v=tHAiK8td0hQ&list=PLckEMv5tz0E5zWRpjwnHX6a6nFSTcpWD2&index=18&pp=iAQB
https://www.youtube.com/watch?v=FpoLEXUFfBc
https://www.youtube.com/watch?v=FpWU-M-7qL8

Handy Techniques

In this section we share some handy techniques to help you get the best out of Gaia. It's
worth a quick read, as their impact on your game can be significant.
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Using your own custom player / camera

A lot of Gaia’s systems, especially the runtime components, require to know what your
main camera is in the scene and what the object is that represents the player. For example
the Gaia water object needs to know what the main camera is to correctly display under
water effects for that camera.

When you set up one of Gaia’s controllers this is done automatically for you, but what do
you do when you want to run your custom controller? If your controller is part of the
scene during design time, please check the “Custom Controller” option inside the Controller
Setup Runtime Component:

Gala Manager

Gaia Pro (4.0.0-¢5, Unity 2022.3.0f1) -=DEV =- English

- 3. Create Runtime (Optional)
v Caontroller Setup

Remove Apply

« Gaia Water

Remove Apply

+ Lighting Presets

y to receive your FREE stamp packs, yport forum, knowledge base library, tutorials, and much maore.

This option allows you to name your character and camera, and Gaia will make those
known to all required systems when you click the Apply button.

If you spawn your Character / Camera during runtime, you can use the API function
GaiaAPI.SetRuntimePlayer AndCamera

to perform this step from within a script. This allows you to register your dynamically
spawned player from code with Gaia’s systems.
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Use Biomes to create your own look and feel

In Gaia, stampers modify the shape of a terrain, and spawners fill it with content. It is
convenient to use the spawners that come with Gaia and call it a day, but you will always
get better results if you start to customize or to build your own spawners according to the
needs of your project.

The "Customizing Biomes and Spawners” section in this manual is a good starting point for
this.
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Use Perspective and terrain impostors to create space

It is difficult to create massive worlds in Unity because the terrain system does not scale.

The problem is that as soon as Unity is displaying more than a few terrain tiles, your frame
rates will plummet.

In Gaia Pro, we mitigate this by creating low poly mesh-based impostor terrains with
streaming and culling.

However, even then, massive draw distances inherently mean that the engine needs to do
more work, and this will impact your performance.

The solution is to cheat and create the illusion of space by using scale and perspective!

In this example on a relatively small terrain, we created a sense of vastness by putting a
mountain range in the distance and adding some haze.

To do this we added a bunch of stamps on the far side and shrunk them to make them
seem distant.

When doing this, be sure to remove trees or other assets in the distance that could break
the illusion unless you also shrink those as well.

We naturally perceive the world around us based on what we have experienced. In this
example, as there is nothing to tell us different, we assume this is a large environment.
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Another good technique is to create islands with Gaia and use the Terrain mesh conversion
system convert it to a low poly mesh impostor.

Then save that as a prefab, and bring it them in as game objects, and shrink them and place
them in the distance off your coast. Make sure your remove the original terrain from your
prefab!

You can experiment with the export settings to fit the export within your performance
profile.
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Use culling, streaming and light baking to increase performance

The fundamental truth of game development is that the bigger the world, the more you
spawn, the heavier it is, the slower it will render, and slow frame rates break immersion.

Our customers use Gaia to make popular games in VR, on mobile, desktop, and console, but
as with all things, every game requires optimization to make it run well.

You need to balance the asset render cost, visual density, draw distances, and the size of
your environment against your target hardware and audience.

One of the main approaches to improving performance is to not render the content in the
first place. You can achieve this with a combination of clever level design and technology.

Layer based culling
o Gaia spawns content into layers, and the
following script is automatically added to the
players that are spawned into the scene by

2 LN o R LT &l Gaia’s optional runtime system.

- Global Settings |

Transform

The layers are based on object size, and are

Third Person

e Camera Toiye CEEEEEE into PW_Object_Small, PW_Object_Medium,
e and PW_0Object_Large based on the object size.
e The culling distance for these objects can be
Camera Culing controlled per layer. The idea here is to send

1 T less drawcalls the GPU by displaying less
s il obiects.

You can update these settings yourself. There
is always a tradeoff between the amount of
content and the visual fidelity, and this changes
from scene to scene.

ulling To Defaults

Revert Shadow To Defaults
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Terrain culling, streaming and impostor meshes

Gaia Pro helps to manage performance on larger worlds by breaking each tile up into a
separate scene and using the Unity scene streaming system to stream them in only when
needed. This system also culls the terrain (hides it), when it is not in view so that it does not
consume resources.

Another optional feature is the terrain mesh impostor system in Gaia Pro. In this process,
each terrains scene is saved in two scenes. One contains the original terrain, with
vegetation etc, and the other is saved in a separate scene as a low poly mesh. Gaia will then
load the low fidelity mesh based terrains in the distance instead of the high fidelity unity
terrain. This faster to load and render.

You can learn more about this on Canopy.

Occlusion culling

A low tech, but useful approach is to use the Unity occlusion culling system, and
strategically placed natural barriers such as hills and mountains to minimise what gets
rendered.

This system should be used with caution, as while this removes load from the GPU, it
increases load on the CPU.

You can mitigate this by merging meshes into groups. Our Scene Optimizer system does
this and can provide significant performance benefits in scenes with many game objects.

Light baking

Lightmaps are important as they store the information than the Unity GI (global
illumination) system needs to light your scene properly.

Gaia offers the “Quick Bake” option in the Runtime tab which will populate the basic lighting
settings for the scene so that the ambient light in the scene will be correct.

You can have both baked and real time lightmapping in your scene also known as mixed
lighting. To learn more about lighting in general, please visit these links:

https://unity3d.com/de/learn/tutorials/topics/graphics/choosing-lighting-technique
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Use Audio and VFX management (Gaia Pro)

If you take a closer look at the spawners included in Gaia Pro, you will notice that some of
those also spawn Audio sources and particle effects on the terrain:

If you look closer into the resources that these spawners add to the terrain, you will find
that they place audio sources and particle effects on the terrain. Both are optimized to only
to be active when the player is near. You can harness the same systems to bring particle
systems and audio effects to your scene in certain areas.

To spawn optimized audio sources, place the Gaia Audio Zone script on the prefab that

hosts the audio source. It allows you to play back different, randomized audio samples
from the same source.
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Bl v Gaia Audio Zone (Script)
Gizmo Settings

Gizmo Color
- Audio

& This A ibal Audio Source

A MatureDay

A MNatureDay2

A MNatureDay3

Fade In

Fade Out

Add Zone [tem

Make sure you also got the Gaia Audio Manager script on your camera. There is an option to
add it in the controller setup component, if you create your own player you would need to
add it manually.

Likewise you can add the PW_VFX_Manager script to your particle systems to make them
play back only when the player is near.

+ PW_VFX_Manager (Script)

F _Sp_Butterfly {Particl
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Use Github to protect your work

Source control can be tedious, until you need it, which you will, then you will wish you had
it. In addition to saving your work, it becomes a handy way of trying ideas out, and saving
them for later on a different branch.

You can get free accounts at github.com, and you can get a free git client here. Another
good git client is called Fork and you can get it here. | prefer the more visual nature of
Fork.

You need to make sure that you install LFS (large file services) support with you git client
in order to use it effectively, and then you need a special file called .gitattibutes to tell git
which files types are to be considered large binary files.

We have included samples of .gitignore and .gitattributes here for you to use as a base.

Then create and copy the contents of the following .gitignore and .gitattributes into their
respective files root of your Unity directory. At this point git should now treat your
repository correctly.

.gitignore

#

# Get latest from https://github.com/github/gitignore/blob/main/Unity.gitignore
#

/[Lllibrary/

/[Tt]lemp/

/[0olbj/

/[Bbluild/

/[Bbluilds/

/[Lllogs/

/[Uulser[Ss]lettings/
# MemoryCaptures can get excessive in size.
# They also could contain extremely sensitive data

/ [Mm] emoryCaptures/

# Recordings can get excessive in size

/[Rr]ecordings/

# Uncomment this line if you wish to ignore the asset store tools plugin

# /[Ralssets/AssetStoreTools*
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# Autogenerated Jetbrains Rider plugin

/[Aa]ssets/Plugins/Editor/JetBrains*

# Visual Studio cache directory

.vs/

# Gradle cache directory

.gradle/

# Autogenerated VS/MD/Consulo solution and project files
ExportedObj/
.consulo/
*.Ccsproj
*.unityproj
*.sln

*.suo

*.tmp

*.user
*.userprefs
* . pidb
*.booproj
*.svd

*.pdb

*.mdb
*.opendb

*.VC.db

# Unity3D generated meta files
*.pidb.meta
*.pdb.meta

*.mdb.meta

# Unity3D generated file on crash reports

sysinfo.txt

# Builds
*.apk
*.aab

*.unitypackage
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*.app

# Crashlytics generated file

crashlytics-build.properties

# Packed Addressables

/ [Aa]lssets/[Aa]lddressable[Aa]ssets[Dd]lata/*/*.bin*

# Temporary auto-generated Android Assets
/[Ralssets/[Ss]treamingAssets/aa.meta

/[Ralssets/[Ss]treamingAssets/aa/*

# Procedural Worlds Assets

/[RAa]ssets/Procedural Worlds/*

.gitattributes

Create an empty .gitattibutes file in the root of your Unity project directory. The copy this
into it and check it in to your repository.

Files with these defined file types will be stored as binary blobs by git. This is not only
faster and more efficient, it also gets around the github file size limit. Add new file binary
file types as needed.

### Standard

#4# git-1fs ##

*.3dm filter=1fs diff=1fs merge=1lfs -text
*.a filter=1fs diff=1fs merge=1lfs -text
*.al filter=1fs diff=1fs merge=1lfs -text
*.aif filter=1fs diff=1fs merge=1lfs -text
*.asset filter=1fs diff=1fs merge=1fs -text
*.blend filter=1fs diff=1fs merge=1fs -text
*.block filter=1fs diff=1fs merge=1fs -text
*.bytes filter=1fs diff=1fs merge=1lfs -text
*.cfl filter=1fs diff=1fs merge=1fs -text
*.dae filter=1fs diff=1fs merge=1fs -text
*.dll filter=1fs diff=1fs merge=1lfs -text
*.docx filter=1fs diff=1fs merge=1lfs -text
*.exr filter=1fs diff=1fs merge=1lfs -text

*.fbx filter=1fs diff=1fs merge=1lfs -text
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*.gif filter=1fs diff=1fs merge=1lfs -text
*.glb filter=1fs diff=1fs merge=1fs -text
*.gltf filter=1fs diff=1fs merge=1lfs -text
*.hdr filter=1fs diff=1fs merge=1lfs -text
*.jpeg filter=1fs diff=1fs merge=1lfs -text
*.jpg filter=1fs diff=1fs merge=1lfs -text
*.1xo filter=1fs diff=1fs merge=1fs -text
*.max filter=1fs diff=1fs merge=1lfs -text
*.mov filter=1fs diff=1fs merge=1fs -text
*.mp3 filter=1fs diff=1fs merge=1fs -text
*.mpd4 filter=1fs diff=1fs merge=1fs -text
*.0bj filter=1fs diff=1fs merge=1fs -text
*.o0gg filter=1fs diff=1fs merge=1fs -text
*.pdf filter=1fs diff=1fs merge=1fs -text
*.pdf filter=1fs diff=1fs merge=1lfs -text
*.png filter=1fs diff=1fs merge=1lfs -text
*.psd filter=1fs diff=1fs merge=1lfs -text
*.pwcfg filter=1fs diff=1fs merge=1fs -text
*.rar filter=1fs diff=1fs merge=1fs -text
*.reason filter=1fs diff=1fs merge=1fs -text
*.rns filter=1fs diff=1fs merge=1fs -text
*.tga filter=1fs diff=1fs merge=1fs -text
*.ttf filter=1fs diff=1fs merge=1fs -text
*.u3d filter=1fs diff=1fs merge=1fs -text
*.unity filter=1fs diff=1fs merge=1lfs -text
*.unitypackage filter=1fs diff=1fs merge=1lfs -text
*.usd filter=1fs diff=1fs merge=1lfs -text
*.usdc filter=1fs diff=1fs merge=1lfs -text
*.usdz filter=1fs diff=1fs merge=1lfs -text
*.vsdx filter=1fs diff=1fs merge=1fs -text
*.wav filter=1fs diff=1fs merge=1fs -text

*.zip filter=1fs diff=1fs merge=1fs -text
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